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Preface 
 

The World Anti-Doping Agency (WADA) which aims to promote, coordinate and monitor the fight 
against doping in sport, revised the World Anti-Doping Code and its changes took effect on 1 January 
22015. Those changes to the World Anti-Doping Code were adopted and implemented in its FIVB 
Medical Regulations, which were approved by the 2014 FIVB Congress held in Sardinia (ITA). 
http://www.fivb.org/en/FIVB/Document/Legal/FIVB_Medical_and_Anti-
Doping_Regulations_2015_en_20141208.pdf 

 
The FIVB Medical & Anti-Doping Regulations in line with WADA Rules foresee in Article 5.6 the 
Athletes Whereabouts Requirements as outlined below: 
 
5.6 Athlete Whereabouts Requirements  
 

5.6.1 FIVB shall identifyé.. 

5.6.1.1 FIVB may include in its Testing Pool(s) any Athlete not included in the Registered Testing Pool and 

require such Athlete to provide and update, either directly or through his club or National Federation, specific 

whereabouts information requested by the FIVB. Failure to comply with FIVBôs requirements, in addition to 

possible Consequences under these Anti-Doping Rules, may lead to (a) a sanction for a minor offence in 

accordance with the FIVB Disciplinary Regulations; (b) the Athleteôs inclusion in the Registered Testing Pool. 

 
The FIVB identified the FIVB Testing Pool for Volleyball which includes 20 National Teams (10 Men  
and 10 women Teams) participating in FIVB competitions according to the FIVB National 
Federations Ranking. These National Teams are required to provide whereabouts information  
 

starting 15 May up until 15 October 2017  

http://www.fivb.org/en/FIVB/Document/Legal/FIVB_Medical_and_Anti-Doping_Regulations_2015_en_20141208.pdf
http://www.fivb.org/en/FIVB/Document/Legal/FIVB_Medical_and_Anti-Doping_Regulations_2015_en_20141208.pdf
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15 May 2017 
 
National Federations, which are welcome to transfer these duties to their Team Managers, shall be 
responsible to provide all information required accurately and in sufficient detail to enable responsible 
Anti-Doping Organizations wishing to locate any Athlete of the Team for Testing on any given day in the 
above mentioned period. This also includes Individual Whereabouts in those cases where Athletes do 
not participate in team activities, i.e. because of injuries, changes within the team, or similar. 
 
Failures to file Whereabouts or to be located for testing will be sanctioned with Whereabouts Failures 
according to Article 5.6.2 of the FIVB Medical Regulations and Articles in Annex1 of the WADA 
International Standard for Testing (IST). 
Team Whereabouts shall be filed online by using WADAs Anti-Doping Administration & Management 
System (ADAMS). The system has been adapted to fit Volleyball needs and National 
Federations/Team Manager will find subsequent instructions on how to use the system in order to fulfill 
its Team Whereabouts obligations. 
 

VOLLEYBALL TEAM MANAGEMENT ï how to file Whereabouts via ADAMS 

The following document guides a National Federation/Team Manager, thereafter ñNF Team Managerò, 
through the process of filing Whereabouts for its National Volleyball Team in the ADAMS-System.  
 
It gives the NF Team Manager instructions on how to proceed step by step in order to provide the 
necessary information to fulfill FIVB Team Whereabouts requirements. 
 
FIVB grants access to NF Team Managers to create, edit and read Team activities (which also include 
Whereabouts of individual members of the team, when not with the team).  
 
The basis for team activities constitutes all Athletes registered on the ñO2 Formò, which is used to enter 
National Teams for FIVB competitions. This form will also have to be attached in ADAMS. Team 
activities, as well as individual Whereabouts for Athletes not with the team for specific reasons, 
including but not limited to injuries, changes of the teams, etc. have to be filed. 
 
NF Team Managers should be aware of their responsibility to file complete and accurate Whereabouts, 
as sanctions for him/National Federation as well as for the individual Athletes are foreseen. 
 
Please also note that you are handling confidential and sensitive data. Therefore, you must apply 
appropriate, sufficient and effective privacy protections to Personal Information that you Process and 
comply with the WADA International Standard for the Protection of Privacy and Personal Information 
(ISPPPI). 

https://www.youtube.com/watch?v=bv9wdohU_vg 

http://www.google.ch/imgres?imgurl=http://thumbs.dreamstime.com/x/deadline-icon-14138452.jpg&imgrefurl=http://www.dreamstime.com/photos-images/deadline-icon.html&h=400&w=400&tbnid=AKCm-yCrHT-azM:&zoom=1&docid=xQMkOOxvBMYIkM&ei=6Z4vVZ2bBMbLaIjZgagM&tbm=isch&ved=0CCsQMygjMCM4ZA
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Before You Start 

Supported Browsers 

ADAMS is currently supported on the following browsers: 

¶ Firefox Version 3.6+ 

¶ Microsoft Internet Explorer Version 8+ 

 

To verify which version you are running, click Help /About from the browser's main menu bar. 

The Safari browser on Macintosh platforms is still not officially supported, although most of the issues 

encountered in the previous version users have been resolved for Safari Version 5. Should you encounter any 

technical issues while using ADAMS on a Macintosh computer, please report it to your ADAMS custodian 

organization and indicate the platform used. 

Should you experience any technical issue while using a different browser, please try again using one of the 

above browsers. Free versions of the browsers are available at the following addresses: 

¶ http://www.mozilla.com/en-US/firefox/all.html 

¶ http://www.microsoft.com/windows/internet-explorer/worldwide-sites.aspx 

Clear your Browser Cache ï IMPORTANT! 

If you used a previous version of ADAMS, it is possible that your cache contains information that will conflict with 

a more recent version. 

In any case, always clear your cache before you use a new version of ADAMS. To obtain detailed instructions on 

how to proceed for your specific browser, you can refer to pages such as the following: 

http://www.wikihow.com/Clear-Your-Browser%27s-Cache. 

http://adams-docs.wada-ama.org/display/EN/Before+You+Start
http://www.mozilla.com/en-US/firefox/all.html
http://www.microsoft.com/windows/internet-explorer/worldwide-sites.aspx
http://www.wikihow.com/Clear-Your-Browser%27s-Cache
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In a nutshell: 

¶ If you are using Internet Explorer, select Internet Options from the Tools menu. Depending on the IE 

version you are using, you may click the Delete then the Delete Filesé button in the Temporary Internet Files 

section of the General tab. Check the Delete all offline content checkbox and click Ok to clear your cache. 

¶ If you are using Firefox, select Clear Private Data or Clear Recent History from the Tools menu. Make 

sure the Cache checkbox is selected; the other checkboxes can be blank. Then click the Clear Private Data Now 

or OK button. 

Allow Pop-ups 

 

Enabling the pop-up blocker may prevent some screens from appearing. In the Internet Explorer "Tools" menu, 

select "Pop-up Blocker Settings" and add adams.wada-ama.org to your "Allowed sites" list. 

¶ If you are using Internet Explorer, select "Pop-up Blocker Settings" from the "Tools" menu and add 

adams.wada-ama.org to your "Allowed sites" list. 

¶ If you are using Firefox, select "Options" from the "Tools" menu. In the "Content" tab, click the first 

"Exceptionsé" button and add adams.wada-ama.org to your "Allowed Sites" list. 

ADAMS includes a detector on the login page which will warn users if a pop-up blocker is enabled and inform 

them that ADAMS requires the use of pop-ups to execute properly. 

Screen Resolution 

Make sure that your screen resolution is set to 1024x768 pixels for optimum performance. This can be set in 

Display Properties within Control Panel in a Windows operating environment. 

Using a Bookmark 

If you experience difficulties logging into ADAMS, it may be because your bookmark (if any) for ADAMS is not 

correct. For access to the Production system, ensure that your bookmark is set to: https://adams.wada-ama.org. 

The "s" suffix in https must be present. Remove any extra characters following the URL. To verify the URL: 

¶ If you are using Internet Explorer, click the Favorites button to display your bookmarks on the left hand 

side of the screen. Right-click the ADAMS bookmark, and select Properties. Ensure that the URL displayed 

exactly matches the one shown above. 

¶ If you are using Firefox, select Sidebar from the View menu, then select Bookmarks to display your 

bookmarks on the left hand side of the screen. Right-click the ADAMS bookmark, and select Properties. Ensure 

that the URL displayed exactly matches the one shown above. 
 

https://adams.wada-ama.org/
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¶ Time Out ï For security reasons, ADAMS has been configured to time out after a certain period of 

inactivity. If you do not submit any data or click any of the links for this period of time, ADAMS will log you 

off the system. The maximum idle period is 30 minutes; should you exceed that period, then you will need 

to log in again. 

¶ Back Button ï ADAMS does not support the use of your browser Back button and in most areas of the 

site you will discover that it does not work. Therefore it is required that you navigate through ADAMS by 

using the appropriate links. You can always return to the My zone page by clicking the ADAMS logo in 

the upper-left corner of the page: 

¶   

¶ One ADAMS Session Per User ï You can only have one single ADAMS session at a time. Should you 

try opening another session for the same user on a different computer or browser, the initial session will 

be deactivated and the following message will be displayed: 

 
 

 

 

11..   ñLoginò with the login/password provided by the FIVB to your National Federation. When 

accessing for the first time, you will be requested to change your password (8 digits minimum).  
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22..  Optional: You can change ADAMS to your preferred language by clicking on ñyour name on 

the top right or where it says ñhereò. To select your preferred language, pick the relevant one 

in the drop down and ñsaveò. 

 

 

 

 

33..  Continue by clicking on ñGroups managementò, in order to access the information related to 

team activities. 

 

 

 

 

 

44..  Then, click on the link Whereabouts Team/Group Management. 
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55..   A team for your National Federation should already exist. Therefore click on ñsearchò and all 

teams will be listed. Click on ñeditò in order to add or remove Athletes who do not belong to 

your team. Select Athletes by ticking the box. 

 

PLEASE NOTE:  
Should these athletes not be found, meaning that no account exists in the ADAMS 
system yet, please click on ñnew athleteò, fill in the details requested and click on the 
ñSaveò button. 

 Important:  Create new Athletes only when no account had been previously created  
Never create a second account for the same Athlete! 

 

66..  To create a new Athlete click on ñnew personò and a new window will appear.  
 
 

 
 

http://www.google.ch/imgres?q=exclamation+mark&hl=en&sa=X&qscrl=1&nord=1&rlz=1T4ADFA_enCH412CH416&biw=1301&bih=655&tbm=isch&prmd=imvns&tbnid=pUJqhsMXnCiR-M:&imgrefurl=http://mariokartwii.wikia.com/wiki/Category:Images&docid=Op-rlzdgE8y0pM&imgurl=http://images.wikia.com/mariokartwii/images/9/9b/Red_Exclamation_Mark.png&w=600&h=500&ei=-O5UT_m-Joaj4gSu9sDiDQ&zoom=1
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Please fill in all mandatory fields (as well as birth date) and Save. 
 

 
 
 
 

¶ Once you added all Athletes to the team, click on ñContactò (5) and fill in all fields 
requested, including your email address and mobile number; 

¶ Click on ñSaveò (6). 
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77..  Please continue by clicking on the tree on the left hand side. It states Whereabouts, years (i.e. 

2015-Q2) and months (i.e. May 2015). By selecting a month in the tree (for instance May 

2015), you have access to the calendar of the selected month which will appear like the 

following: 

 

 

 

 

1

 

2 

 

3 

5 

6 

4 
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88..   To add an Attachment, firstly, please click on the green button ñNEWò, select the date range 
(O2 Form) references to (you have to define start date (at least 6 weeks prior to the respective 
competition) and expiry date (end date of competition)). Provide a name for the attachment. 
Then browse through your files and attach the O2 Form by clicking SAVE. 

 
 
 
Attachments will be shown as a paper clip icon 
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99..  Next, you will have to enter all hotels, trainings, matches, travels and other team activities for 

each day in the 6 weeks prior to the start of the competition up until the end of the Team`s 

participation in the respective competitions. In order to do that, 1) click on the ñnewò button or 

directly on the selected days, the New Entry window will appear, 2) and then complete with the 

Address, Category (hotel, activity, competition). You can select as many days 3) as you want 

by choosing Recurrence (weekly, daily, specific dates) and then 4) Save it. 

 

 

Whereabouts entries are shown with the background color corresponding to their category: 
orange for Overnight Accommodation, green for Competition, yellow for Regular Activity, 
training, blue for Travel and grey for Other, medical, theory session.  

 
 

 
 
 
 
 

1

é

é 

 

1 

2 

3 

4 
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PLEASE NOTE:  
 

You must file any overnight stays, training, matches, travels and other team 
activities for each day of the period requested. In addition, you have to file Individual 
Whereabouts for Athletes who are not with the team for any reason, such as but not 
limited to injuries, changes within the team, and similar. At least 1 location and 60-Min. 
Time slot per day is required (see below p.15) 

 
 

1100..  Please enter the information related to the match(es), training(s) or overnight stay(s): 
 
V The name of the match (i.e. Friendly match BRA vs. SUI) 
V Training (i.e. Volleyball training, fitness training, etc.)  
V Overnight stay (i.e. Hilton Hotel)  

The schedule of the match or training, start and end time 
 
 

 
 

 
V Tick the box ñEntire Teamò 

http://www.google.ch/imgres?q=balloon+volleyball,+photos&hl=fr&sa=X&rlz=1T4ADFA_enCH412CH416&biw=1301&bih=655&tbm=isch&prmd=imvns&tbnid=rNc-OGnPyI8yrM:&imgrefurl=http://www.casalsport.com/VAD/ballon_de_volley_mikasa_mva_350_/p,1,1,1,24383.htm&docid=qQkYsMenOHNPbM&imgurl=http://www.casalsport.com/phproduit/20091026/vb189_F.jpg&w=276&h=276&ei=YNxUT9_MJ6fi4QSS1t2sDQ&zoom=1
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V Insert the full and accurate address of the location (make sure you include a Label and a Street  

number, city and country) 

 

 

V In the field ñAdditional Informationò, you may enter additional information regarding a location 

and also the Individual whereabouts players Information.  

 
 
 

1111..   Individual Whereabouts 
 

As mentioned above in the field ñNew Entryò New addressò this is where you state Athletes 
not participating in team activities and where you file their individual Whereabouts 
containing the Athlete`s name and exact address and mentioning at least 1 hour per day 
(one hour slot) in the Additional Information field. 

 

 Important: Individual Whereabouts should be filled as the Examples shown 
below : 

 
Ex. 1) Player : Stancic Robert, Doctor appointment Dr Balcic Dorfstrasse 2, Berlin, 
Germany, one hour slot  8 am ï 9 am 
 
Ex. 2) Player : Stancic Robert, Home address: International Volleyball Federation, Chateau 
Les Tourelles, Edouard-Sandoz 2-4, 1006 Lausanne, Switzerland, one hour slot 7PM-8PM. 

http://www.google.ch/imgres?q=exclamation+mark&hl=en&sa=X&qscrl=1&nord=1&rlz=1T4ADFA_enCH412CH416&biw=1301&bih=655&tbm=isch&prmd=imvns&tbnid=pUJqhsMXnCiR-M:&imgrefurl=http://mariokartwii.wikia.com/wiki/Category:Images&docid=Op-rlzdgE8y0pM&imgurl=http://images.wikia.com/mariokartwii/images/9/9b/Red_Exclamation_Mark.png&w=600&h=500&ei=-O5UT_m-Joaj4gSu9sDiDQ&zoom=1
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Athletes must be always able to be located at those places and during the time given 
 
 
 
 
 
If you want to modify an Address, or add Additional Information, click on Address Book, 
choose the Address, Edit, and then Save. 
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1122..   Optional: Should the team train for a longer period of time or certain training locations recur 

more often, you may DUPLICATE the Location at a later stage and avoid retyping these 

locations several times. In order to do that, click ñDuplicateò then fill in all requested 

information and click on the ñsaveò button. 

 

 

 



 

Volleyball Team Whereabouts Handbook                                                       18 of 19 | P a g e 

 

1133..   After inserting all matches, training camps, hotels and other team activities your screen should 

look similar to the one below: 
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1144..  Optional: you may click on ñList viewò if you want to see the team activities recorded and a 

report like the one below will be generated. 

 

 

 Important: Should you want to update or change the information provided, always click ñeditò 

first, make your changes and click on ñsaveò in order to save your changes. 

 

 


